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Dear LapLink Customer:

You may be a first-time LapLink user or one of the dedicated users who have followed LapLink 
from earlier versions. Either way, you are sure to benefit from the significant improvements 
and refinements we have built into LapLink Gold version 11.5.

It is now even simpler to connect and begin using file transfer, synchronization, and remote 
control. The “Connect Over” menu has been shortened to offer quick access to the kinds of 
connections you are most likely to make: modem, LAN, cable. To this list we have added our 
new easy Internet connection method using the LapLink Everywhere network. This 
connection is available worldwide, from any computer or device with an Internet connection, 
regardless of firewall or router configurations.

The purchase of LapLink Gold 11.5 entitles you to unlimited use of LapLink Everywhere for a 
full 30 days. You can use all of the LapLink Everywhere services—e-mail, file, forms, and 
remote desktop access—from any browser-enabled device in the world including phones, 
PDAs, Internet café's, and so on.

If you connect over a USB cable, you will appreciate the effort we put into USB cable 
connections. In previous versions, we used the Microsoft networking model. Unfortunately, 
this required the installation of software drivers and resulted in complexities no customer 
should have to deal with. We have now written our own direct-connect USB software, and it 
works just like the LapLink of years past: Just plug in the cable and, bingo, you hear our 
connection sound and the connection opens automatically! Moreover, this new software 
supports USB 2.0, for transfer speeds up to 40 megabytes per second!

For ease of use, flexibility, and power, we believe this is the best LapLink we have released to 
date.

Finally, many of our longtime customers know we have recently experienced difficult times. 
Rest assured, those days are now past, and a new company called “LapLink Software” is 
ready to support you and create more amazing remote access and synchronization products. 
Please do let us know how we are doing and what new capabilities you would like to see in 
future versions or products. Please email your ideas to “Feedback@LapLink.com”.

Best regards,

President
LapLink Software, Inc.

Fast Easy Access Everywhere
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Welcome to LapLink Gold 11.5
With LapLink® Gold’s award-winning remote control, file transfer, and chat features, you can access e-
mail, files, and office network resources when you’re on the road, work with computer users at other loca-
tions, schedule file transfers, print documents to a remote printer, and more. LapLink offers you a variety of
reliable, easy-to-use options for connecting; simply choose the option that is appropriate for the resources
available on your computer and the computer you want to connect to. To learn more about LapLink, see the
online user’s guide and Help.

Whether you’re on the road, at home, or in the office, LapLink Gold lets you work 
faster, easier, and smarter than ever by providing safe and reliable remote access.

• For more 
information about 
connecting to another 
computer, see page 16.

Using LapLink Gold to connect to another LapLink computer is easy. Depending on 
the resources available on your computer and the computer you want to connect to, 
you can connect using:

• LapLink Everywhere 
is fee-based service. 
With the purchase of 
LapLink Gold 11.5, you 
are entitled to use this 
service for 30 days 
without charge.

Once you’re connected, you’re ready to use LapLink’s powerful features.

• Remote Control lets you use your computer to perform tasks on another 
computer.

• File Transfer lets you move and copy files between computers, specify how files 
should be moved and copied, and synchronize the files in folders on two 
computers automatically. 

• Print Redirection lets you print a remote document at your site or use a remote 
printer to print a local document.

• Text Chat and Voice Chat let you communicate with other users by exchanging 
text messages or talking over a connection between two sound-enabled 
computers.

• File synchronization simplifies the repetitive tasks necessary to keep files 
updated when you use two computers. You can even schedule synchronizations to 
run unattended.

• a modem
• a LapLink serial, parallel, or Universal Serial 

Bus (USB) cable
• a wireless connection, including Fast Infrared 

(FIR) connection
• the Internet, with or without the LapLink 

Everywhere service

• a local (IPX) network, such 
as Novell 

• a TCP/IP network
• a CAPI/ISDN 2.0 device
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• To download 
LapLink documentation 
from the Web, go to 
www.laplink.com/
products/llGold/
docs.asp

Learning more about LapLink Gold: online user’s guide and Help

You can learn about LapLink Gold through the online user’s guide and Help. The 
online user’s guide is available in Adobe Acrobat format on the LapLink Gold CD-
ROM. Adobe Acrobat is also available on the LapLink Gold CD-ROM.

• To download Adobe 
Acrobat Reader from 
the Web, go to 
www.adobe.com  

To view the online user’s guide:

1 Display the LapLink Welcome screen by inserting the LapLink Gold CD-ROM in 
your CD-ROM drive. 

2 Click View Documentation on the LapLink Welcome screen. 

3 The guide immediately opens in Acrobat Reader.

LapLink Gold also features an online Help system to assist you as you use LapLink. 
Help is available through the LapLink Help menu, including: 

Searchable Help documentation Browse Help, and use the Help Index and Find 
features to search for specific information. On the LapLink Help menu, click Help 
Topics.

Troubleshooters Specify the problem you are having, and troubleshooters walk you 
through a series of possible solutions. In Help, double-click the Troubleshooting 
book.

Quick Steps Quick Steps appear when you open a dialog box in LapLink and give 
you information to help you complete the dialog box. 

What’s This Help Use the What’s This Help to get information about dialog box 
items. Click the question mark in the upper right hand corner of the dialog box, and 
then click the item you want help with. 

F1 Help To get immediate help for an item on a menu, highlight the menu item and 
press the F1 key.

Getting help with LapLink Everywhere

Once you have logged on to the LapLink Everywhere site (www.mylaplink.com), 
you can get answers to the most frequently asked questions by clicking the Help tab 
on the main window. On the host computer, you can access Help by double-clicking 
the LapLink Everywhere icon in the system tray and opening the Help menu.

Getting more information about LapLink

Visit LapLink Technical Support at www.laplink.com/support/. Visit 
www.laplink.com/world/ for international support.
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What’s new in LapLink Gold 11.5
Ease of use was again a top priority in creating this version of LapLink Gold. Once complicated by network
considerations, USB connections are now as easy as those over serial and parallel cables; and file-transfer
speeds, using USB 2.0, are the fastest ever. The addition of the LapLink Everywhere service means that you
can now connect securely over the Internet, without having to worry about firewalls and other security con-
siderations. LapLink Everywhere connections are unique: you can use them to establish traditional
LapLink-to-LapLink connections; or you can read e-mail, transfer files, and perform other tasks from any
device with which you can browse the Internet, including cell phones, PDAs, and public access computers
like those found in libraries and Internet cafés.

Improved USB connections

In earlier versions, USB connections were similar to network connections, requiring 
the use of a network driver. Now you can make a direct connection over a LapLink 
USB cable just as you would over a LapLink serial or parallel cable, without the 
hassle of configuring your computer for a network connection. Just attach a LapLink 
USB cable to two computers running LapLink Gold, version 11.5, and a connection 
opens automatically.

You can benefit from this improved USB connection using the LapLink USB cable 
(version 1.1) included with LapLink Gold 11.5. Or you can purchase a new cable and 
benefit from the increased speeds of USB 2.0 (as fast as 40 megabytes per second). 
For details, go to www.LapLink.com. (To achieve these speeds, computers at both 
ends of the cable must be set up for USB 2.0.)

Easy Internet connections

Making a LapLink connection over the Internet can be daunting if either computer is 
located behind a firewall. By adding the LapLink Everywhere connection, LapLink 
Gold provides an easy and seamless way to navigate personal and corporate firewalls 
without compromising security.

Firewalls are set up to protect against unwanted incoming connections. LapLink 
Everywhere connections, however, are established as outgoing connections to the 
LapLink Everywhere Center, even through data can flow freely in both directions. 
Firewall configuration is no longer necessary, and no security holes are created in 
your existing security configuration.

LapLink Everywhere is a fee service. With the purchase of LapLink Gold 11.5, you 
are entitled to try this service free for 30 days. When opening your account, you go to 
the secure LapLink Everywhere server and set up a unique user name and password. 
Then you download the small LapLink Everywhere program and install it. After that, 
just running LapLink Gold on your computer allows secure connections from other 
LapLink Gold computers over the Internet.
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Connecting from a Web browser

There may be times when you want a file or an e-mail message from your home or 
office desktop but setting up your laptop and running LapLink is not convenient or 
feasible. For such situations, you can leave the LapLink Everywhere program running 
on your desktop and connect from a PDA or any other device that can surf the 
Internet. You can open a connection from almost any browser, even in libraries and 
Internet cafés.

• The LapLink Secure 
VNC client for 
Windows must be 
running on any 
computer you want to 
control remotely 
through LapLink 
Everywhere.

Working within a Web browser on your Internet device, you can perform some of the 
same operations you perform within LapLink:

• Read and send e-mail messages, adding attachments as you wish

• Upload and download files to and from your desktop

• Control your desktop remotely

• Access SQL databases on servers connected to the desktop

LapLink Everywhere connections

A LapLink Everywhere connection 
starts as an outgoing connection from 
a home or office computer to the 
LapLink Everywhere Center. 
Firewalls control incoming 
connections while allowing LapLink 
Everywhere and other outgoing 
connections.

The LapLink Everywhere Center 
maintains incoming connections 
from home or office. This allows 
users to link to their home and 
office computers through the 
Center.

All data passing over these connections is 
protected by encryption.
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Installing LapLink Gold 11.5
Before you install LapLink Gold 11.5, make sure you have what you need to use the program on the com-
puters you want to connect. Once you’ve verified your setup, you’re ready to install LapLink. To use all of
its features and services, LapLink must be installed on both computers you want to connect.

• For information on 
installing LapLink 
Everywhere, see page 
“Setting up LapLink 
Everywhere” on 
page 12.

General requirements for each computer

• Microsoft Windows 95, 98, 2000, Me, NT 4.0, or XP 

• Intel or Intel-compatible 486/100 processor (or better)

• 16 MB of memory (24 MB recommended) 

• 25 MB of available hard disk space (for a complete installation)

• Microsoft mouse or compatible pointing device

Requirements for modem communication

• Windows 95/98/Me: Windows- or Hayes-compatible modem

• Windows NT/2000/XP: Modem set up in Windows NT/2000/XP (with TAPI)

Requirements for network communication

• For IPX connections: Microsoft IPX-compatible protocol configured for a 
network adapter

• For TCP/IP connections: Microsoft TCP/IP-compatible protocol configured for 
a network adapter 

• The network must function correctly without NetBEUI protocol installed

Requirements for Dial-Up Networking communication

• Guest computer: Dial-Up Networking feature of Windows installed, with a Dial-
Up Networking connection to the dial-up server

• Host computer: Running a dial-up server program, or accessible through a 
dedicated dial-up server that supports incoming Dial-Up Networking connections

• Dedicated dial-up 
servers include Novell 
NetWare Connect and 
Intel/Shiva NetModem.

Requirements for cable communication

• For USB connections: A LapLink USB cable and a USB port on each computer. 
(Both LapLink USB cables—1.1 and 2.0—support Windows 98, Windows 2000, 
Windows Me, and Windows XP.)

• For serial connections: A LapLink serial cable and an RS-232 serial (COM) port 
on each computer

• To purchase cables, 
visit www.laplink.com.

• For parallel connections (Windows 95/98 and Windows Me): A LapLink parallel 
cable and a parallel (printer) port on each computer, or a Direct-Parallel Universal 
cable and an Extended Capabilities Port (ECP) on each computer 
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Requirements for wireless communication (Windows 95/98 and Me)

• In LapLink, wireless 
connections are short-
range, usually between 
two infrared devices. If 
you are using a cellular 
modem, connect using 
Connect over Modem. 
If you are using a 
wireless LAN adapter, 
connect using Connect 
over Network.

Infrared devices include: 

• Ports and devices supported by the Windows Infrared communications driver 
(IrDA) 1.0 or 2.0 (driver installed on both computers)

• Devices such as the Extended Systems JetEye Infrared PC Interface (baud-
switchable only), configured to work in LapLink

• Built-in infrared devices, including Fast Infrared (FIR)

Requirements for CAPI 2.0/ISDN communication

• An ISDN line and ISDN adapter with a CAPI 2.0-compliant driver on both ends 
of the connection

Requirements for Voice Chat (must be installed on each computer)

• A sound card or sound device, speakers or headphones, and a microphone (A full 
duplex sound card driver is recommended.)

Installing LapLink Gold 

To install LapLink Gold:

• If the LapLink 
Welcome screen does 
not appear, open 
Windows Explorer and 
double-click 
Startup.exe on the 
LapLink CD-ROM.

1 Insert the LapLink CD-ROM in a CD-ROM drive or, if you downloaded LapLink 
from the Web, double-click the Welcome.exe file in the folder where you 
downloaded LapLink.

2 Click Install LapLink Gold, and follow the instructions on the screen. 

When prompted, be sure to use names that clearly describe each computer.

Installing LapLink Gold on a second computer

You can install LapLink Gold on a second computer that does not have a CD-ROM 
drive. You can use the blue serial cable or floppy disks.

To install LapLink Gold using the serial cable:

1 On the taskbar, click Start, point to Programs, point to the LapLink Gold program 
group, and then click Remote Install.

2 Follow the instructions that appear on your screen.

To install LapLink Gold using floppy disks:

1 On the Welcome screen, click Make Setup Disks.

2 Follow the instructions that appear on your screen.
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Installing LapLink Gold 11.5
Setting up LapLink Everywhere
Your purchase of LapLink Gold 11.5 entitles you to 30 days’ free use of the LapLink Everywhere mobile
access service. LapLink Everywhere is a separate program and, unlike LapLink Gold, needs to be installed
on only one computer—on the home or office computer you want to connect to. LapLink Everywhere is a
service provided by LapLink Software, Inc. For subscription rates and other information, go to
www.LapLink.com.

Unlike LapLink Gold, the LapLink Everywhere program needs to be installed only 
on the host computer—the home or office computer you want to connect to. It does 
not have to be installed on the computer you connect from.

Once the LapLink Everywhere program is installed on the host computer, you can 
connect in two ways:

• Only LapLink-to-
LapLink connections 
offer the complete 
range of LapLink 
features. When you use 
a Web browser, you can 
read e-mail, transfer 
files, and perform 
remote control, but 
advanced features like 
automatic 
synchronization are not 
available.

• Open a LapLink connection from another computer running LapLink Gold. 
LapLink Gold must be running on both computers, but LapLink Everywhere 
needs to be installed and running only on the host.

• Open a LapLink Every connection from a Web browser. Simply leave LapLink 
Everywhere running on the host computer. You do not have to run LapLink at all.

Requirements for the host computer

• Windows 98, Windows ME, Windows NT, Windows 2000, or Windows XP

• 5 MB of free hard disk space

• A persistent connection (by DSL or cable) to the Internet

• Microsoft Outlook 97, 98, 2000, 2002 (for access to E-Mail, Contacts, Calendar, 
Notes, and Tasks), or Outlook Express 5.0 or greater (for access to E-Mail and 
Contacts)

• For maximum 
flexibility, leave both 
LapLink Gold and 
LapLink Everywhere 
running on the host 
computer. You can then 
connect from another 
computer running 
LapLink Gold and from 
any device that allows 
you to browse the 
Internet.

For access from a Web browser, the host must meet these requirements:

• For remote control (at additional cost), LapLink Secure VNC or WinVNC

• To send e-faxes, a valid account with an Internet e-fax service

• To access a SQL database, a SQL database server to for which you have an ADO 
connection string. In addition, the remote device must have Microsoft Data 
Access Components (MDAC) 2.6 or later installed on it.

Requirements for the remote device

You can connect to the host computer from almost any device equipped to browse the 
Internet—from another PC or a Mac to a PDA or an Internet telephone. The chief 
requirement is that the device must be set up to allow cookies. 
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To access a SQL database on the host computer, the remote device must have 
Microsoft Data Access Components (MDAC) 2.6 or later installed on it.

Installing LapLink Everywhere on the host computer
• Your user name and 
password are not case 
sensitive. For example, 
susieq is interpreted the 
same as SusieQ.

As part of the installation of LapLink Gold you are asked whether you want to set up 
your LapLink Everywhere account.

Simply create a unique user name and password. You will need them to access the 
host computer from a browser through the LapLink Everywhere Center. If you install 
LapLink Everywhere on more than one computer, be sure to use the same user name 
and password for each one.

The LapLink Everywhere setup guides you through a few self-explanatory wizards. 
Simply follow the directions on the screen.

• For more 
information about 
configuring LapLink 
Everywhere, click 
Frequently Asked 
Questions on the Help 
menu.

When the wizard is finished, the LapLink Everywhere host is installed and its icon 
appears in the system tray, in the lower right corner of your screen. By double-
clicking the LapLink Everywhere icon you can perform a variety of useful tasks 
including these:

• Monitor past and current activity over your LapLink Everywhere connection.

• Allow other users to access your computer over the LapLink Everywhere 
connection and specify the privileges each of them will enjoy. For example, you 
deny some users access to certain file folders and e-mail folders.

• Set up password protection for the settings you set up on the host computer, 
including the privileges you grant to other users.

Monitoring and configuring LapLink Everywhere

To monitor activity over 
your LapLink Everywhere 
connection, grant other 
users privileges, and 
perform a variety of other 
tasks, double-click the 
LapLink Everywhere icon 
in the system tray.
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Getting started: setting security and allowing others to connect
After you install LapLink Gold, you can make outgoing connections to other computers, but other comput-
ers cannot open incoming connections to yours except by cable and wireless. To allow incoming connec-
tions, change the security setup by creating one or more entries in the Log-in List or by allowing public
access. You can restrict user access as necessary, specifying who can connect to your computer and what
they can see and do once connected.

• To set up security for 
cable and wireless 
connections, click the 
Enforce Security option 
on the Local Security 
tab. For more 
information, see the 
online user’s guide and 
Help.

The safest way to allow incoming connections is to set up password-protected access 
through the Log-in List. However, you can also set up your computer as a public 
system, open to anyone who can connect. 

Once you’ve configured your security setup, users can access your computer using a 
modem, network, CAPI 2.0/ISDN device, or the Internet. You won’t need to modify 
this setup unless your security needs change.

Allowing others to connect to your computer

To specify who can connect to your computer:

1 Click the Security button on the LinkBar.

• No special security 
configuration is 
required for you to 
access your computer 
from a Web browser, 
over the LapLink 
Everywhere service.

2 On the General tab, click Log-in List Only (Protected System).

3 Click the Log-in List button, and then click the Add button.

4 On the General tab, type the log-in name and password the user must provide to 
connect to your computer. 

5 Under Services, check the services that you want to make available to the user, 
such as Remote Control, File Transfer, and Surf Up.

6 If you’ve checked Remote Control as an available service, check the appropriate 
options under Locking Permissions to indicate whether the user can blank your 
computer screen and disable its mouse and keyboard. 

• For more 
information about 
selecting options on the 
Folder Security and 
Modem Callback tabs, 
see the online user’s 
guide and Help.

7 Specify any additional user access restrictions and preferences on the Folder 
Security and Modem Callback tabs.

8 Click OK to add this person to your Log-in List. 

A LapLink user can now connect to your computer by typing the log-in name and 
password you specified.

You can also open your computer to connections from any LapLink user if you 
choose. Though public users do not need to enter a password to access your computer, 
you can limit what they can see and do.

To allow public access to your computer:

1 Click the Security button on the LinkBar.
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2 On the General tab, click Anybody (Public System).

3 Click the Public Privileges button.

4 On the General tab, check the services and locking privileges you want to grant to 
public users.

5 To limit public access to particular drives and folders, click the Folder Security tab.

6 Click OK.

Setting up security in LapLink

Click Log-in List Only (Protected System) to allow 
only people with names and passwords you’ve 
specified to log in to your computer. Then, click the 
Log-in List button to enter log-in information and 
user restrictions. 

Or click Anybody (Public System) to allow access 
to your computer without password protection, and 
then click the Public Privileges button to specify 
what users can see and do.

Adding someone to the Log-in List

Type a log-in name and password for the remote 
user. The remote user will have to type this when 
connecting.

Specify the services the remote user can use.

If you allow Remote Control, specify whether you 
allow blanking of your computer screen and locking 
of your keyboard and mouse.

To set up security, click the Security button on the 
LinkBar.

To specify additional restrictions and connection 
preferences for this user, click the appropriate tab.
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Deciding how to connect
LapLink Gold gives you a variety of methods to connect to your home or office computer. To choose the
appropriate method, determine what resources will be available at both ends of the connection.

• For instructions on 
how to connect to 
another computer, see 
page 18.

Before you can use LapLink Gold to connect to another computer, you must 
determine how to make that connection using the resources available to the two 
computers.

For example, if you are using two computers with Internet access, you can connect 
over the Internet. If one computer has a modem and the other has a modem and 
network access, you can connect over a modem line.

Connecting from another LapLink computer over the Internet

• When you connect 
using a Web browser, 
you can read your 
e-mail, transfer files, 
and so on. But 
automatic file 
synchronization and 
many other advanced 
LapLink features are 
available only in a 
LapLink-to-LapLink 
connection.

Connecting from an Internet browser

You can use the LapLink Everywhere service to connect two computers running 
LapLink. You can also use it to connect to your home or office computer from any 
Web browser. Simply run the LapLink Everywhere program on your computer 
(LapLink Gold does not have to be running) and leave the computer connected to the 
Internet when you go on the road. You can then access your computer from any 
device equipped to browse the Internet: another PC, a MAC, a PDA, a cellular 
telephone, and so on.

Connecting over modems, networks, cables, and wireless devices

Can you connect to 
the Internet on the 
local computer?

Then connect from another LapLink computer over the Internet 
this way:

Yes If either computer is located behind a firewall, consider using Con-
nect over LapLink Everywhere (Internet) for secure connections 
without the hassle of configuring a firewall.
Otherwise, connect to the Internet as usual, and then use Connect over 
Internet Locator Service (ILS) in LapLink. 

No, but the office has 
a direct connection to 
the Internet.

Use Connect Over Dial-Up Networking to dial in to a network server 
and connect over the office Internet connection.

With this 
available on 
the local 
computer

And this 
available on 
the remote 
computer

Connect to another computer running LapLink this 
way:

modem modem Use Connect over Modem and dial in to the modem on 
the remote computer.
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Connecting through a firewall

LapLink Gold offers three methods of making connections through a firewall:

Connect using LapLink Everywhere (Internet)  LapLink Everywhere ensures 
secure connections and requires no configuration of firewalls.

Configure your firewall  If you are a home user or have full access to the firewall 
configuration, you can use the firewall’s port forwarding feature to allow LapLink 
connections from outside your firewall: configure port forwarding for the LapLink 
port (1547) to the computer inside the firewall. (See your firewall documentation for 
more information.)

• For more detailed 
information about 
configuring LapLink to 
work through a 
firewall, see the online 
user’s guide and Help.

Use LapLink’s Firewall Connection Service  Corporate users can use Firewall 
Connection Service. This method takes advantage of an ILS server and allows 
LapLink to make a secure reverse connection from inside the firewall. To enable this 
feature, both computers require some minor configuration:

• On the computer inside the firewall, set up your LapLink Security to allow an  
incoming connection (Log-in List) from the computer outside the firewall.

• On the computer inside the firewall, create an Address Book entry for the 
computer outside the firewall and select Firewall as the connection type.

• On the computer outside the firewall, create a Log-in List entry with Firewall 
enabled as a service. The login name and password must match the entries made 
in the Address Book on the computer inside the firewall.

modem modem and net-
work

Use Connect over Modem to connect directly to the 
remote computer and access all of the network resources 
available to that computer. 

modem network with a 
dial-up server

Use Connect over Dial-Up Networking to dial in to the 
dial-up server and connect to any LapLink computer on 
the network.

network network Use Connect over Network.
parallel, serial   
or USB port

parallel, serial, 
or USB port

Attach a LapLink parallel, serial, or USB cable to each 
computer. The connection opens automatically. (Paral-
lel connections are available in Windows 95/98 and 
Windows Me.)

wireless device wireless device The connection opens automatically as soon as the 
devices come within range of each other. (Wireless con-
nections are available in Windows 95/98 and Windows 
Me.)

With this 
available on 
the local 
computer

And this 
available on 
the remote 
computer

Connect to another computer running LapLink this 
way:
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Connecting to another computer
To use all of LapLink’s features, you must first connect to another computer. Computers at both ends of the
connection must be running LapLink Gold. Click the Connect Over button on the LapLink LinkBar and
then specify how you want to connect. Then, provide the connection information.

Important: Before you can connect to another computer, both computers must be 
running LapLink, and the connection method you want to use (such as modem or 
network) must be active and available. You may also need to know a log-in name and 
password in order to connect.

The only exception to this rule is a LapLink Everywhere connection, which lets you 
connect from any device able to browse the Web. The small LapLink Everywhere 
program must be running on the computer you are connecting to (the host computer); 
you only need a Web browser to complete the connection.

• To determine the 
best way to connect to 
another computer, see 
page 16.

Making a connection

How your computer connects to another computer depends on the resources available 
to the two computers. Determine what types of connections each computer is able to 
make, and then select the appropriate connection option.

To connect to another computer:

• Not all connections 
are supported in all 
versions of Windows; 
see page 10 for details.

1 Click the Connect Over button on the LinkBar, and then click the connection 
method you want to use. 

2 Under Services, check the services you want to open when you connect. (You 
must check at least one service.)

When you use LapLink Everywhere, you do not request services until you have 
logged on to the LapLink Everywhere site.

3 Specify how to connect as described below:

Modem Use this method for modem-to-modem connections. Click Manual Dial 
and type the dialing information for the remote computer, or click an existing 
connection name. Click Dial.

Dial-Up Networking Use this method to connect to a network with a dial-up 
server using a modem. 

Click the Dial-Up Networking connection you want to use and choose the 
appropriate dial-up networking options. Click Dial to dial your modem. Once 
you’ve connected, LapLink asks you to specify which LapLink computer on the 
network you want to connect to.

LAN (network) Use this method to connect to a computer on the same network. 
Choose a computer on the network by clicking the computer name. 
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You can also connect to a computer by typing its TCP/IP address; click the TCP/IP 
Addresses tab, click Manual Connect, and type the TCP/IP address. Click OK.

LapLink Everywhere (Internet) Use this method to connect to another LapLink 
computer over the Internet, using the LapLink Everywhere service. The purchase 
of Laplink Gold 11.5 entitles you to 30 days’ free use of this service.

Cable (USB, Parallel, Serial) Use this method for computers connected by one 
of the LapLink cables (serial, parallel, or USB). The computer connected to your 
computer by cable is listed in the Connection list. Click the computer name and 
click OK.

• If you can’t connect, 
make sure that the other 
computer is running 
LapLink, is set up to let 
you connect, and that it 
allows the services that 
you requested. For 
troubleshooting 
information, see the 
online user’s guide and 
Help.

Wireless Use this method to connect computers that have infrared wireless 
devices and are in range of each other. If a computer with a wireless device is in 
range of your computer, it is listed in the Connection list. Click the computer name 
and click OK.

Internet Locator Service (ILS) Use this method if both computers have Internet 
access and the address of the remote computer is published on the host’s Internet 
directory server. Click Manual Dial and type the remote computer’s Internet 
address, or click an existing connection name. Click OK.

4 If prompted, type your log-in name and password. The connection is made, and 
the services you selected are opened if the remote computer is set up to allow you 
to access those services. 

Connecting in LapLink Gold

The Connect dialog box looks 
different depending on the 
method you use to connect.

If necessary, change any of the 
connection information.

Check the services you want to 
open when you make the 
connection. 

Then, click the connection method you want to use. (These 
can vary depending on your computer setup.)

First, click the Connect Over button.

LLgold_QS11five.fm  Page 19  Thursday, May 22, 2003  12:42 PM



LapLink Gold Quick Start Guide

20

Connecting to another computer
Connecting by cable
To connect two computers by LapLink cable, attach the cable (serial, parallel, or USB) to both computers
and start LapLink on both computers. 

• A USB 1.1 cable is 
included in the LapLink 
Gold 11.5 package. If 
your computers support 
USB 2.0, you can get 
faster transfers using 
the new LapLink USB 
2.0 cable. To purchase 
one of these cables, 
visit www.laplink.com.

Choose the type of cable—serial, parallel, or USB—based on the cables and ports you 
have available and the operating systems running on both machines. 

Ports are the connectors to which you attach cables and peripherals (like printers and 
external modems). To find out which types of ports are available on the computers 
you want to connect, consult the documentation or Windows Device Manager for 
each computer.

Once you decide which kind of cable connection you’ll use, plug the appropriate 
LapLink cable into both computers. Attach a LapLink serial cable to a serial port on 
each computer, a LapLink parallel cable to a parallel port on each computer, or a 
LapLink USB cable to a USB port or USB “hub” device on each computer.

Before you connect by cable

• Run LapLink on both computers.

• Attach an end of the LapLink cable to each computer.

• Ensure that the proper port (serial, parallel, or USB) is enabled in LapLink on both 
computers.

To enable a port on a computer, click the Options menu, and then click Port Setup. 
Under Port Settings, highlight the port you want to enable, and then check the 
Enable Port box. (USB ports are automatically enabled during installation.)

Cables to use for LapLink connections

For a serial, parallel, or USB cable connection, use any of the LapLink cables 
available from LapLink Software.

If more than one type of cable port is available to you, remember that USB and 
parallel cable connections are the fastest. Using USB 2.0, the newest LapLink USB 
cables can now transfer data as fast 40 megabytes per second. In addition, you can 
attach a USB cable to any USB peripheral that incorporates a “hub” to which other 
devices can be connected. This feature lets you use more than one USB-compatible 
device at a time.
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Connecting to another computer by cable
• If AutoConnect is 
enabled but the 
connection does not 
open automatically, 
click Port Setup on the 
Options menu and 
verify that the 
appropriate port (COM, 
LPT, or USB) is 
enabled for cable.

When you start LapLink on two computers that are connected by a cable, LapLink 
connects the computers automatically. If necessary, you can also open a cable 
connection to another computer manually.

To manually connect to another computer by cable:

1 Click the Connect Over button on the LinkBar, and then click Cable.

2 In the Connection list, click the name of the computer you want to connect to.

3 Under Services, check the services you want to use, and click OK.

Connecting by cable: serial, parallel, and USB

Serial cable: Note that the blue 
LapLink serial cable has two 
connectors (one large, one small) at 
one end, but you only need to connect 
one of these two connectors to a 
computer. Which one you use 
depends on the ports that are 
available. 

Use the larger connector if one of the 
computers has a 25-pin serial port. 
Otherwise, use the smaller connector. 
Make sure that one end of the serial 
cable is attached to a serial port on 
each computer. 

Parallel cable: Attach 
one end of the yellow 
LapLink parallel cable 
to a parallel port on each 
computer.

Parallel cable 
connections are not 
available in Windows 
NT or Windows 2000.

USB cable: Attach one 
end of the LapLink USB 
cable to a USB port or 
USB hub on each 
computer.

USB connections are not 
available in Windows 95 
or Windows NT.
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Controlling a remote computer
Remote Control lets you use your computer to perform tasks on another computer. When you connect to the
remote computer, you become a Remote Control guest and the remote computer becomes the host. When
you’re connected to a Remote Control host, you can lock the host’s keyboard and mouse and blank the host
screen; you can also reboot the host. To add more security to your remote control session, you can start
LapLink before you log on to Windows.

• The LapLink 
Everywhere feature lets 
you remotely control a 
computer from any 
Web browser. See 
“What’s new in 
LapLink Gold 11.5” on 
page 8 for more 
information.

You can remotely control another computer (be a guest), or let another computer 
running LapLink control your computer (be a host).

Acting as a guest  When you’re a guest, the host appears on your screen in a Remote 
Control window within LapLink. You can use your mouse and keyboard to work on 
the host computer.

Acting as a host  When your computer is a Remote Control host, other people with 
access rights to your computer can connect to and work on your computer. To act as a 
host, your computer needs to be running LapLink and to be set up to allow others to 
connect.

You can open a Remote Control window while connecting or after a connection is 
opened.

• To open a Remote Control window while connecting, click the Connect Over 
button on the LinkBar, and then click Modem, Network, or some other mode of 
connecting. Under Services, check Remote Control.

• To open a Remote Control window after connecting, click the Remote Control 
button on the shortcut bar, or click Open Remote Control on the Window menu.

Locking and blanking the host computer
• To permit locking 
and blanking on the 
host, change the 
Locking options in the 
Security dialog box on 
the host computer.

When you control a computer, you can lock the computer’s keyboard and mouse and 
blank the computer screen. This prevents people from working on the host system or 
from viewing your work. You must set up the host computer to allow locking and 
blanking. 

With the permission of the host computer, you can:

Lock the host keyboard Prevents anyone from typing on the host computer’s 
keyboard while you’re connected.

Lock the host mouse Prevents anyone from using the mouse on the host computer 
while you’re connected.

Blank the host screen Blanks the host’s screen, preventing someone at the host 
computer from watching what you do while connected.

LLgold_QS11five.fm  Page 22  Thursday, May 22, 2003  12:42 PM



Controlling a remote computer23

23

To lock and blank the host computer after connecting, click Blank Screen, Lock Host 
Mouse, or Lock Host Keyboard on the Session menu. If these options are not 
available, the host computer might not be set up to allow locking and blanking.

Rebooting the host computer
• To permit rebooting, 
change the rebooting 
option in the Remote 
Control Options dialog 
box on the host 
computer. 

You can reboot a computer you’re controlling if the host computer is set up to let you 
do this. For example, you might want to restart a host computer to put into effect 
changes you have made on that computer or to recover from problems with a program 
on that computer.

To reboot the host computer from the guest:

• On the Session menu, click Reboot Host.

Additional security: starting LapLink before the Windows logon
• When using LapLink 
on Windows NT or 
Windows 2000, Remote 
Control guests must log 
on by clicking Send 
CTRL+ALT+DELETE to 
Host on the guest 
computer’s Session 
menu, or by pressing 
CTRL+SHIFT+D.

You can require someone who wants to access your computer as a guest to type a 
Windows user name and password. To do this, set up LapLink to start before you log 
on to Windows.

To start LapLink before logging on to Windows:

1 Click Program Options on the Options menu.

2 Click the Advanced tab.

3 Check the Always Start LapLink Before Windows Logon Prompt box, and then 
click OK.

Controlling a remote computer

Remote Control guest Remote Control host

When you use Remote Control, the entire desktop of the remote computer is shown in LapLink. 
You can then work on that computer as if you were right in front of it. (To alternate between a 
window view and a full-screen view of the host, press CTRL+SHIFT+F.)
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Transferring files and printing over a LapLink connection
Once you have connected to another computer, you can transfer files between computers and use Xchange
Agent to synchronize folders and files on both computers. You can also print a file on a remote computer to
your local printer or print a file on your computer to a remote printer. 

• The LapLink 
Everywhere feature lets 
you transfer files to and 
from a computer from 
any Web browser. See 
“What’s new in 
LapLink Gold 11.5” on 
page 8 for more 
information.

Transferring files

When you connect to another computer and open File Transfer, you can transfer files 
and folders between that computer and your computer.

To start File Transfer and select the items you want to transfer:

1 Click the File Transfer button on the shortcut bar, or click Open File Transfer on 
the Window menu.

Two File Transfer windows appear, one for the remote computer and one for your 
computer. In these windows, you can view the files on both computers.

• To distinguish 
between the two File 
Transfer windows, look 
for the computer name 
in the title bar at the top 
of each window.

2 On the left side of the File Transfer window for the computer you want to copy or 
move a file from, click the drive and folder in which the file is located. 

3 On the right side of that window, click the folder or file you want to transfer.

• To select more than one item, hold down CTRL as you click each item.

• Another way to 
select a group of files or 
folders is to click the 
right corner of the 
group and drag to the 
opposite corner, 
forming a selection 
box.

• To select two or more items listed next to each other, click the first item and 
press SHIFT while you click the last item.

To drag and drop the selected files:

1 Drag the files to the target.

• To copy the files, hold down CTRL and your left mouse button as you drag 
them to the target folder.

• To move the files, hold down SHIFT and your left mouse button as you drag 
them to the target folder. 

• To set preferences 
for copying and 
moving, use the File 
Transfer Options dialog 
box; for more 
information, see the 
online Help.

2 In the File Copy or File Move dialog box, do any of the following:

• Under To, verify the target, and change it if necessary.

• Under Options, check or clear the options as needed. For more information, see 
the online Help.

3 Click OK.
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• For more 
information about 
Xchange Agent, Clone 
Folder, and 
SmartXchange, see the 
online user’s guide and 
Help.

Automating file transfers

LapLink’s Xchange Agent, Clone Folder, and SmartXchange™ features automate the 
process of keeping the files on two computers in sync.

You can use these features to ensure that the most recent versions of the files and 
folders you specify are saved to both computers. You can even schedule 
synchronizations to run unattended.

Printing over a LapLink connection

Use Print Redirection to send a document from the computer at one end of the 
connection to a printer at the other end. 

• Print from remote to local While using Remote Control to view and operate 
another computer, you can send a document from that computer to a printer at 
your location. 

• You may need your 
Windows CD-ROM or 
printer disks to install 
the printer driver.

• Print from local to remote When connected to another LapLink computer, you 
can print a document from your computer to a printer at the remote location. 

To print a document over a LapLink connection, choose the Print command in the 
program in which you have prepared the document, and then choose a printer at the 
opposite end of the connection.

Before using Print Redirection, you must add a printer driver  to the computer you 
want to print from. (Add the driver to the computer that doesn’t have the destination 
printer attached to it.)

You can add a printer driver during LapLink installation or use the Print Redirection 
Setup wizard after installation. 

• To set up a printer after LapLink installation, click Print Redirection Options on 
the Options menu, and then click the Setup button to start the Print Redirection 
Setup wizard. 
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Talking over a LapLink connection: Text Chat and Voice Chat
Using Text Chat or Voice Chat, you can communicate with someone at the other end of your LapLink con-
nection. Text Chat lets you exchange typed messages with the other person, while Voice Chat lets you speak
to the person. 

Using Text Chat

You can use Text Chat to exchange typed messages with a person at the other end of 
your LapLink connection. 

A Text Chat window consists of two parts:

• The upper part displays the messages you send to the remote user as well as those 
the remote user sends to you. Each message is identified by the name of the 
computer from which it was sent.

• The lower part serves as a note pad on which you write your messages. It clears 
each time you send a message.

To send a message to the remote user:

1 Click the Text Chat button on the shortcut bar, or click Open Text Chat on the 
Window menu.

2 Click the Text Chat window.

3 Type your message.

Avoid pressing ENTER while you type your message. To start a new paragraph, 
press CTRL+ENTER.

4 Press ENTER to send your message.

Using Voice Chat

Use Voice Chat to talk to someone you’re connected to over LapLink while using 
other LapLink services like File Transfer. To use Voice Chat, you and the person at the 
end of the LapLink connection must both have computers that are capable of 
recording and playing sound.

To talk to someone over Voice Chat:

• Click the Open Voice Chat button on the shortcut bar, or click Open Voice Chat on 
the Window menu.

LapLink “calls” the person at the other end of the connection and asks if he or she 
wants to talk to you. If the person accepts the Voice Chat connection, a Voice Chat 
window opens, and you can begin talking to the other person. Speak into the 
microphone and listen through headphones or speakers.
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• The lower bandwidth 
of slow connections 
may prevent the use of 
full duplex.

Depending on the configuration of the sound card in both computers, your voice and 
the voice of the other user may be transmitted simultaneously, as if you were using a 
telephone (full duplex), or alternately, as if you were using a walkie-talkie (half 
duplex).

Using Text Chat

Read the messages from the remote 
computer—as well as your own—in the 
upper part of the Text Chat window.

Type your messages in the lower part. Press 
ENTER to send.

Using Voice Chat

The Voice Chat window appears while you’re 
connected.

How you communicate over the connection 
depends on whether the current conversation is 
using half duplex or full duplex.

During a conversation, you can adjust your 
speaker and microphone and mute them, if 
necessary.

When you’re using half duplex, watch the 
stoplight icon to determine when to talk. 
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LapLink License Agreement
IF YOU BREAK THE SEAL OR OTHERWISE OPEN THE PACKAGE CONTAINING THE SOFTWARE PROGRAM MEDIA, 
YOU ARE BY THAT ACT AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS LICENSE AGREE-
MENT.

Ownership of Software. You acknowledge and agree that all of the computer programs and associated documentation contained in 
this package (collectively, the “Software”) are owned exclusively by LapLink and/or its licensors. The Software is protected under 
copyright and other intellectual property laws of the United States and international copyright treaties. You acknowledge and agree 
that the price paid by you for the Software is a license fee granting you only the rights set forth in this License Agreement.

License. LapLink grants to you, and you accept, a limited, non-exclusive and revocable license to use the Software, in machine-read-
able, object code form only. You agree to use the Software only as authorized in this License Agreement. This License Agreement 
does not convey to you any ownership rights or any other interest in the Software.

Scope of License. This is a single-user, multiple computer license, which means you are authorized to use the Software on up to a 
total of three personal computers that are used exclusively by you (e.g., office, laptop and home). A valid license must be purchased 
for each person who will use the Software. You may only use the Software to link with a computer not used solely by you if the user 
of that computer has a valid license.

If this software is to be installed on a network server, or more than one user can run the Software, you must purchase an additional 
license for each user or work station. Please contact the location where you purchased the Software and this license, or contact 
LapLink, to obtain additional licenses.

You may not copy or make any changes or modifications to the Software, and you may not translate, decompile, disassemble, or oth-
erwise reverse engineer the computer program(s). You may not loan, rent, lease or sublicense the Software or any copy to others for 
any purpose. You agree to use all reasonable efforts to protect the Software from unauthorized use, modification, reproduction, dis-
tribution or publication. You are not permitted to make any uses or copies of the Software that are not specifically authorized by the 
terms of this License Agreement, and LapLink reserves all rights that are not expressly granted to you. Your adherence to this License 
Agreement will allow LapLink to continue developing innovative and useful products and providing a high level of customer service 
and support.

Term. This license will become effective on the date you acquire the Software and will remain in force until terminated. You may 
terminate this license at any time by removing the Software from your computer and destroying the original Software and all copies. 
This license will automatically terminate if you breach any of the terms or conditions set out in this License Agreement. You agree 
to remove the Software from your computer, and either to destroy the original Software and all copies of the Software and documen-
tation or to return them to LapLink, upon termination of this license for any reason.

Transfer. You may transfer your license of the Software to another party by transferring the original program media and all applicable 
documentation, including the original of this License Agreement, to the recipient, who agrees to the terms of this Agreement. All 
other copies of the Software must be deleted and/or destroyed. Any transfer of possession of the Software terminates your license and 
all associated benefits under this License Agreement. You must notify LapLink in writing of such a transfer.

Archival Copy. You may make one copy of this Software and associated documentation solely for backup or archival purposes. Alter-
natively, you may transfer this Software to a single hard disk drive, provided that you keep the original program media and accom-
panying documentation in your possession for backup or archival purposes. Any such copies of the Software or documentation shall 
include LapLink’s copyright and other ownership notices. No other copies of Software or documentation may be made by you or any 
person under your authority or control.

Limited Warranty. LapLink warrants the physical program media and physical documentation to be free from defects in materials 
and workmanship for a period of 30 days from the date of your purchase. If you notify LapLink of defects in materials or workmanship 
during the warranty period, LapLink will replace the defective program media or documentation or, at its option, refund the purchase 
price. Your remedy for breach of this warranty shall be limited to replacement or refund and shall not encompass any other damages. 
No dealer, distributor, agent or employee of LapLink is authorized to make any modification or addition to the warranty and remedies 
stated above.

LAPLINK SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIM-
ITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. LAPLINK 
DOES NOT WARRANT THE PHYSICAL PROGRAM MEDIA, PHYSICAL DOCUMENTATION OR COMPUTER PRO-
GRAM(S) OTHER THAN AS EXPRESSLY STATED ABOVE, NOR DOES LAPLINK PROVIDE ANY WARRANTY AS TO 
THE OPERATION OF THE SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR APPLICATION, USE, OR PURPOSE.
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Limitations of Liability and Remedies. IN NO EVENT SHALL LAPLINK OR ITS LICENSORS HAVE ANY LIABILITY FOR 
ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL, PUNITIVE, OR SPECIAL DAMAGES, WHATSOEVER, INCLUDING 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSI-
NESS INFORMATION, AND THE LIKE ARISING OUT OF THIS AGREEMENT, THE LICENSING OF SOFTWARE BY 
LAPLINK OR THE PROVISION OF MAINTENANCE AND SUPPORT SERVICES BY LAPLINK, EVEN IF LICENSEE HAS 
ADVISED LAPLINK OF THE POSSIBILITY OF SUCH DAMAGES, AND INCLUDING UNDER ANY CLAIM OF NEGLI-
GENCE, STRICT LIABILITY, DESIGN DEFECT, OR OTHER THEORY. IN NO EVENT SHALL THE LIABILITY OF 
LAPLINK OR ITS LICENSORS EXCEED THE PURCHASE PRICE PAID FOR THE SOFTWARE, LESS ALL APPLICABLE 
TAXES AND DUTIES. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATIONS OF LIABILITIY FOR INCI-
DENTAL OR CONSEQUENTIAL DAMAGES, SO THE AFOREMENTIONED LIMITATION OR EXCLUSION MAY NOT 
APPLY TO YOU.

U.S. Government Restricted Rights. The Software is provided with Restricted Rights. Use, duplication, or disclosure by the United 
States Government is subject to restrictions set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Soft-
ware clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at 
48 CFR 52.227-19, as applicable. Contractor/Manufacturer is LapLink Software Inc., 10210 NE Points Drive, Suite 400, Kirkland, 
WA 98033, U.S.A.

Updates. To receive notification of future Software updates, please complete and return the registration card. Also, please locate the 
serial number of your copy of the Software on the program media. You will need this number to receive updates and technical support 
from LapLink.

Trademarks. LAPLINK, LAPLINK EVERYWHERE and the associated logo(s) are registered trademarks of LapLink Software Inc. 
No right or license to any trademarks owned by LapLink or others appearing in the Software or packaging is granted to you by this 
License Agreement.

Miscellaneous. Unless otherwise restricted by law, you agree that this License Agreement shall be construed, interpreted and gov-
erned by the laws of the State of Washington of the United States of America, without regard to the laws governing conflicts of law. 
If any action is brought by either party against the other regarding any subject matter of this License Agreement, the prevailing party 
shall be entitled to recover, in addition to any other relief granted, reasonable attorney fees and expenses of litigation. You further 
agree that any claim relating to this License Agreement shall be brought in the courts of competent jurisdiction in the State of Wash-
ington. If any term of this License Agreement is declared void or unenforceable by any court of competent jurisdiction, enforcement 
of the remaining terms shall not be affected. No waiver of any right under this License Agreement shall be effective unless in writing 
and signed by both parties. No waiver of any past or present right arising from any breach or failure to perform shall be deemed to be 
a waiver of any future right arising under this License Agreement. This License Agreement sets forth the entire agreement between 
LapLink and you with respect to all matters covered herein.

IF YOU HAVE ANY QUESTIONS CONCERNING THIS LICENSE AGREEMENT, PLEASE CONTACT LAPLINK SOFT-
WARE, INC., AT 10210 NE POINTS DRIVE, SUITE 400, KIRKLAND, WA 98033, U.S.A. (1.800.LAPLINK) OR CONTACT 
YOUR REGIONAL LAPLINK OFFICE.
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